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Exercise 2: Sea 
Level Rise 
 

Visualizing Sea Level Rise in ArcGIS Pro 
Use Case: Sea level rise and its impact to southeast 

Florida communities 
  

 

Sea level rise is a threat to many coastal communities, particularly southeast Florida. Many 
studies have suggested that the greater Miami and Ft. Lauderdale region is ground zero for sea 
level rise in the United States. A very low and flat topography combined with dense population 
right along the coastlines makes this region very vulnerable to rising waters.  

NOAA provides their sea level rise scenarios ranging from 0-6 feet in geospatial format for use 
in GIS applications. In this exercise, you will learn how to access and explore this data using 
ArcGIS Pro. You will do some simple analysis to understand how sea level rise may impact 
building infrastructure. The analysis and data exploration will be done using both 2D and 3D 
visualization. Finally, you will learn to create a virtual fly-through of a 3D scene and export that 
as movie animation. 

 

 

Sub-Sections in Exercise 2 

 
1. Accessing and Exploring NOAA Sea Level Rise Data 
2. Using Basic Analysis to Highlight Sea Level Rise Impacts 
3. Viewing and Assessing Sea Level Rise Data in 3D 
4. Animating a Scene to Create a Virtual Fly-Through 
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Accessing and Exploring NOAA Sea Level Rise Data 
  

 Become familiar with NOAA’s data download site 

The NOAA Office for Coastal Management’s DIGITALCOAST program makes many 
geospatial tools and datasets available for use in GIS applications. One of these is the Sea 
Level Rise Viewer and its associated data. 

 

 Browse to https://coast.noaa.gov/digitalcoast/tools/slr.html.    

 

From this site you can launch the official NOAA Sea Level Rise Viewer, download the sea 
level rise datasets (shapefiles and depth grids), and access map services for use in ArcGIS 
Pro, ArcGIS Online, or other applications. 

 

 Click DOWNLOAD DATA. 

 

You can search by state or county. 

 

 Scroll down to Florida and click the drop down arrow. 

 

Sea level rise data products are made available at regional scales. A variety of different 
product types are available for download.  

These data products are also quite large. For the Broward, Collier, Miami-Dade, Monroe, 
and Palm Beach region, the sea level rise data package is 4.5 GB. In the interest of time, we 
will work with a smaller subset of this data that has already been downloaded. 

 

 Load NOAA sea level rise shapefile scenarios into ArcGIS Pro 

 

 Start a new ArcGIS Pro project and name it Sea Level Rise. Set the 
location to C:\BRIGHTE\. 

 

https://coast.noaa.gov/digitalcoast/tools/slr.html
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 Create a new folder connection to C:\BRIGHTE\data\SLR. 

 Zoom to Miami Beach. 

 

Add the 2ft sea level rise scenario to the map. 

 

 In the main Map ribbon, click the drop down arrow next to Add Data 
button, then click Data. 

 

 

 

 Navigate to C:\BRIGHTE\data\SLR and add the FL_MFL2_slr_2ft layer 
to the map. 

 Right click on the symbol patch and change                                                                              
the color to Moorea Blue. 
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Adjust the view of your map so that you can see just the southern half of 
Miami Beach. 

 

 

 

 Using the swipe tool to visualize impacts 

The Swipe tool is a quick and easy way to compare two layers, or a layer with a basemap. 

 

 On the main menu ribbon at the 
top, click the Appearance tab. 

 Click the Swipe tool.     

 Click one time on the FL_MFL2_slr_2ft layer in the Table of Contents to 
highlight it. 

 Move your cursor to the top middle of the map. 

 

Notice that the cursor changes to an upside down triangle, indicating that the Swipe tool is 
active. 

 

 Left-click and drag your mouse down across the map towards the bottom, 
and then back up. 

 Repeat for the desired effect. 

 

Notice what the impact of just a 2ft rise in sea level for Miami Beach would be. 

 



 

© 2015 UCAR and UNC Asheville   1-6 
 

 Add the FL_MFL2_slr_6ft layer to the map and set its color to Moorea 
Blue. 

 Activate the Map tab from the main menu ribbon at the top of the screen. 

 Click the Basemap drop-down button and change the basemap to 
Imagery. 

 Click one time on the FL_MFL2_slr_6ft layer in the Table of Contents to 
highlight it. 

 Use the swipe tool to see the difference between the 2ft and 6ft sea level 
rise scenarios.  

TIP: When using the Swipe tool, be sure that you have the layer you want to swipe selected 

in the Table of Contents. By default, all other layers that are checked on will appear as 

you swipe. If you don’t want to see certain layers as you swipe, be sure to turn them off. 

 
 When you have finished using the Swipe tool, with the Map                                                    

tab still active at the top, click on the Explore button. 

 

 

Your cursor will retain the function of the last tool you clicked until you change it. Since the 
Explore tool is the main tool for navigating in ArcGIS Pro, this is a good default tool to active 
when you are not using any other tool. If you previously used ArcMap, this would be similar 
to the Select Elements tool. 

 

 Turn the FL_MFL2_slr_6ft layer off, but leave the FL_MFL2_slr_2ft layer 
on. 

 

 View two maps simultaneously 

ArcGIS Pro allows for multiple maps to be viewed at the same time side by side. Your maps 
and scenes can be synchronized to work together via the use of view linking. As you pan or 
zoom in one map, the view extent automatically changes in the other map or maps as well. 
This will work with a mix of 2D amps and 3D scenes or just multiple views of the same type. 

We will add a second map to ArcGIS Pro and then compare the 2ft and 6ft sea level rise 
scenarios. 

 

 On the main menu ribbon, click the Insert tab. 

 Click New Map on the left edge of the Insert tab ribbon. 

 Add the FL_MFL2_slr_2ft layer and change its color to Moorea Blue. 
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Notice that the zoom extent is defaulted to the full extent of the layer. 

 

 Re-activate the original map by click on its name just above the map 
display. 

 

 

You can toggle back and forth between maps by clicking on their tabs above the map 
display. 

 

 On the main menu ribbon, click the View tab. 

 Click the Link Views drop down arrow and then click Center and Scale. 

 Click on the second map (Map1) and notice the extent. 

 

The two maps are now linked, as indicated by the link symbol on the map tabs above the 
map display. Now any time you pan or zoom in one map, the same action will occur in the 
second map. 

TIP: To un-link the maps, click the Link Views button again and the maps will become 

disconnected. 

 

The real value in linking two or more maps is being able to view them side by side. 

 

 Click on and hold the second map’s tab, then drag it away from the 
display. 

 

Notice as you drag the map, a cross of panel indicators appears in the center of the map 
display.  
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 Hover over the right part of the cross (right dock) and release the map. 

 

The map is docked to the right of the original map and both are visible side by side. 

 

 

 

 Now pan or zoom in one map and see watch what happens in the second. 

 Activate the original map, turn the FL_MFL2_slr_2ft layer off and turn the 
FL_MFL2_slr_6ft layer on.   

 Explore these two maps and notice the differences between these sea 
level rise scenarios. 

 When you are finished exploring the maps, make sure the original map is 
active and remove all layers currently in the Table of Contents. 
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 Un-link the maps by clicking the Link Views button again. 

 Close the second map by clicking the X in the map tab heading above the 
map display. 

 In the very top left of ArcGIS Pro, click Save. 

 

 

Using Basic Analysis to Highlight Sea Level Rise Impacts 

 

 Determine which buildings are impacted by 2ft of sea level rise 

 

 Add the FL_MFL2_slr_2ft_RioVista layer to the original map. 

 

By removing the other layers at the end of the previous step and adding this new layer, you 
should automatically zoom to the extent of the new layer. If not, navigate to the Ft. 
Lauderdale area. 

 

 Change the symbology of the layer to be Moorea Blue. 

 Click the Appearance tab. 

 

Just above the swipe tool is the Layer Transparency tool. Adjusting the layer transparency 
allows you to see through one layer to other layers or the basemap underneath. 

 

 Adjust the slider to be about 40%. Alternatively, type 40 into the box to the 
right of the slider and then click enter on your keyboard. 

 

Next you will add a 2D building footprints layer. These building footprints were generated 
through stereo imagery extraction. 

 

 Add the RioVista_Basic_Buildings buildings layer to the map. 

 Zoom in to see the detail of the building geometry. 

 Visually explore the impacts of a 2ft rise in sea level to the buildings. 
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Next we will determine which buildings are impacted by a 2ft sea level rise scenario. We will 
use a geoprocessing tool to perform this analysis. First, we must prepare the layer attribute 
table for the analysis. 

 

 Right click on the RioVista_Basic_Buildings. 

 Click the Attribute Table. 

 

The Attribute Table appears below the map. 

 

 

 

Notice the fields (columns) that are in the Attribute Table. We will add a new field to contain 
the results from our analysis. 

 

 In the top left of the Attribute Table, click the Add button. 

 

A new table view called the Fields editor appears, this is where the Attribute Table can be 
edited. Notice at the bottom of the Fields editor that a new field has been added, indicated 
by the green square located to the left of the bottom row. 
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 Under Field Name, for the new field (bottom row), enter the name SLR. 
Click in the box to make it editable. Click enter on your keyboard when 
done. 

 

For now, this is the only parameter that we need to set up. 

 

 Click the Save button found above the map display. 

 Click the X to the right of the Fields editor name to close it. 

 Close the Attribute Table. 

 

 Next we will perform the analysis. 

 

 On the main menu ribbon, click the Analysis tab. 

 Click the Tools button. 

 

This opens the Geoprocessing window to the right of the map. Similar to the Catalog 
window, it can be docked in place, float, and be set to auto-hide or pinned to stay open.  

 

 In the upper right corner of the Geoprocessing window, click the Pin icon 
to pin the window in place.  

 

 

 

 In the search box, type Select by Location and then hit enter. 

 Find and click the Select Layer by Location tool in the list of results from 
the search. 
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 Populate the first three Parameters as follows: 

1. Input Feature Layer = RioVista_Basic_Buildings 

2. Relationship = Intersect 

3. Selecting Features = FL_MFL2_slr_2ft_RioVista 

 Accept the defaults for the remaining Parameters. 

 In the bottom right of the Geoprocessing window, click Run. 

 

When the tool has completed the process, you will see the notice “Select Layer By Location, 
Completed Successfully” at the bottom of the Geoprocessing window. In the map, notice the 
buildings that are selected and highlighted in light blue. Next we will calculate the new field 
we created in the buildings Attribute Table to indicate which ones are impacted by a 2ft sea 
level rise. 

 

 

 Open the Attribute Table for the RioVista_Basic_Buildings layer. 

 Click the new SLR field to highlight it. 

 Click the Calculate button at the top of the table. 

 In the Geoprocessing window, enter the value of 2 for the SLR = 
parameter 

 

 

 

 Click Run at the bottom right of the Geoprocessing window. 

 Scroll down through the Attribute Table and notice that the value of 2 
was added to the selected features (buildings). 

 Click the Clear button at the top center of the Attribute Table (this clears 
the selected features). 

 Close the Attribute Table. 

 Close the Geoprocessing window. 

 

Symbolize the buildings layer to indicate which ones would be impacted by a 2ft rise in sea 
level. 
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 Click on the buildings layer in the Table of Contents to highlight it. 

 Click the Appearance tab on the main menu ribbon. 

 Click the dropdown under Symbology. 

 Click Unique Values. 

 Under Primary symbology, click the drop down to the right of Field 1, 
select SLR. 

 In the box below, edit the color values so that 0 = white and 2 = red. 

 Below where it says all other values, right click on this row and click 
Delete. 

 

The Symbology window should look like the one below. By default, when symbolizing a 
layer by unique values, ArcGIS Pro (or ArcMap) will always add a random color to any other 
value that is not symbolized manually. If there truly are no values, as in this case, it’s a good 
practice to simply remove that option. 

 

 

 

 Close the Symbology window. 

 

You can now easily see which buildings ae impacted by the 2ft sea level rise scenario. 
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 Save your ArcGIS Pro project. 

Viewing and Assessing Sea Level Rise Data in 3D 

 Extrude the sea level rise scenarios to visualize impacts 

In the previous exercise you were introduced to ArcGIS Pro’s 3D capabilities. In this section 
we will view sea level rise scenarios in 3D, and link our 2D map with a 3D scene. First you 
will create a new 3D scene. 

 

 Click the Insert tab, and then click drop down under                                                       
New Map, and select New Local Scene. 

 Add the RioVista_Detailed_Buildings multipatch                                                                    
layer located in the 3D_Buildings geodatabase.  

 

These detailed 3D buildings are in multipatch format and                                                                           
typically require a lot of computer memory to work correctly.                                                                      
There may be a slight delay in the layer appearing. 

 

 Using the navigation functions you learned in the                                                                      
previous exercise, explore these 3D buildings. 

 Add the FL_MFL2_slr_2ft_RioVista and the                                   
FL_MFL2_slr_6ft_RioVista layers to the scene. 

 Edit the symbology of both of these layers to be Moorea Blue and set 
them to be 40% transparent (refer to earlier steps). 
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Notice in the Table of Contents that the layers are divided into three categories: 3D Layers, 
2D Layers, and Elevation Surfaces. By default, ArcGIS Pro recognizes that the 3D buildings 
are a 3D layer and places them into the 3D layers category. It also recognizes that the sea 
level rise scenarios are 2D layers and places them into the 2D Layers category along with 
the basemap. Next we will convert the 2ft sea level rise scenario into a 3D layer. This will 
allow us to extrude the layer to a depth of 2ft which will simulate what 2ft of sea level rise 
would look like against some of the buildings. 

 

 Click on the FL_MFL2_slr_2ft_RioVista layer in the Table of Contents 
and drag it up to the 3D layers category just beneath the buildings layer. 

 With the buildings layer still highlighted, click the Appearance tab. 

 Find the Type button and click the drop down arrow, then select Base 
Height (refer to the previous exercise for what these different extrusion 
options do). 

 

 

 

 

 

 Set the Field to Height and the Unit to Feet. 

 

The changes are automatically applied and the 2D layer is extruded to a height of 2ft. 

 

 Explore the scene to visualize which buildings would be impacted by 2ft of 
sea level rise. 
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 Change the basemap to Imagery for a different view. 

 Repeat the previous steps to extrude the 6ft sea level rise scenario and 
visualize what a worst case scenario might look like. 

 

You may notice that with the 6ft sea level rise scenario extruded, the water level appears to 
be much higher than 6ft when compared to the height of some of these buildings. This can 
be due to a couple of reasons: 

1) We are relying on the world elevation layer that is default in ArcGIS Pro. The 
resolution of this layer is not as good as a local, LiDAR-based elevation layer would 
be. In ArcGIS Pro, we could add such a layer and change the settings to reference a 
LiDAR elevation layer for the elevation source.  

2) There are many ways to generate 3D buildings, some more accurate than others. 
These buildings were generated using stereo ortho imagery extraction, however, the 
dense tree canopy did impact the quality of some of the height information. 

It’s important to understand the source and quality of your data before making decisions 
based on it. 

 

 Add bookmarks for quick navigation to views of interest 

Bookmarks can store preset views in your map or scene so that you can easily go back to 
after you navigate away from that location. When a map or a scene is published to ArcGIS 
Online and contains stored bookmarks, the bookmarks are included for easy navigation in 
the hosted service on ArcGIS Online as well. Finally, bookmarks can be used for creating 
animations, which we will do in the next section. 
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 Make sure the Map tab is active. 

 Navigate approximately to the southeast corner of the buildings layer 
extent and then tilt/rotate the scene so that you are looking northwest 
across the Rio Vista neighborhood. 

 Click the Bookmarks button drop down arrow and then click                                               
New Bookmark.  

 Name the bookmark, or accept the default. You do not have to provide a 
description. 

 

 

 

 Navigate to the northeast corner of the layer extent and then tilt/rotate the 
scene so that you are looking southwest across the Rio Vista 
neighborhood. 

 Create a new bookmark. 

 Navigate to the northwest corner of the layer extent and then tilt/rotate the 
scene so that you are looking southeast across the Rio Vista 
neighborhood. 

 Create a new bookmark. 

 Navigate to the west side of the neighborhood where the streets and 
canals are running east-west.  

 Zoom to one of the streets with flooding apparent and then tilt/rotate the 
scene so that you are looking east down that street at the street level (you 
should be zoomed in further than your previous extents). 

 Create a new bookmark. 

 Navigate east down the same street you selected, towards the end. 

 Create a final bookmark. 

 Click the Bookmarks tab and the drop down arrow and then select one of 
your previous bookmarks.  
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TIP: Bookmarks can be edited after they are created. To edit a Bookmark, click the 

Bookmarks dropdown arrow and then select Manage Bookmarks. The Bookmarks 

window will appear on the right, and you can change the name, update the view, or 

delete your bookmarks. 

 

 Save your project. 

 

 Link the Map and Scene 

In an earlier step you learned how link two or more maps together for side by side viewing 
and comparison. Since ArcGIS Pro supports both 2D and 3D, you can link your map and 
scene together for the same side by side viewing and comparison that we saw earlier. 

 

 Click the View tab. 

 Click the Link Views button; be sure to also click the drop down arrow 
and select Center and Scale. 

 

As you did in an earlier step, position your scene so that it will be side by side with your 
map. 

 

 Click on the scene heading and drag it away from the map display. Use 
the cross indicator to position/dock the scene to the right of the map. 
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 Navigate in your scene and notice how the map is automatically updated 
to match the same extent. 

 

When linked, 2D maps can also rotate similarly to the scenes. 

 

 Click the Map tab. 

 Select one of your stored Bookmarks to quickly navigate to a new view – 
watch the 2D map update as well. 

 Un-link the views when you have finished exploring by clicking the Link 
Views button again. 

 

Viewing hazard data such as sea level rise in both 2D and 3D at the same time can provide 
decision makers with added information that traditional 2D platforms are not able to offer. 

 

 Reposition the scene window so that it encompasses the entire map 
display by dragging the scene tab over near the map tab and letting go. 
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Animating a Scene to Create a Virtual Fly-Through 
Animations allow you to tell a story with your 2D and 3D GIS content, such as showcasing a 
critical region or by flying through a 3D view of the area and turning on analysis results. You 
can then export your animation to a common video format. Animations are built by defining a 
small set of keyframes, or waypoints, within the view and configuring how the software 
interpolates the transitions between them. A keyframe contains the viewpoint, layer visibility, 
time, and range properties of the map, which can be used singularly or in combination 
depending on your needs. Bookmarks can be used as keyframes. 

 Prepare your scene for animation 

 

 Click the View tab. 

 Click the Add button found in the                                                                                              
Animation group. 

 

The Animation tab and its contents appear on                                                                                                          
the menu ribbon and the Timeline opens below                                                                                                                                         
the map display. 

We will use the Bookmarks you created earlier to set the keyframes. 

 

 Click the Import button drown down arrow on the left edge of the 
Animation menu ribbon. 

 Select Bookmarks to Fly-Through. 

 

The Bookmarks are added to the Keyframe Gallery in the Animation Timeline. 

 

 Under the Animation tab at the top, set the Duration to be 20 seconds. 

 

 

 

 Click the Play button. 

 

If the speed seems too fast, adjust the Duration to be a longer time.  

 

 Export the fly-through as a movie animation 
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 Click the Movie button.  

 

The Export Move window appears. 

 

 Click the YouTube icon. 

 

ArcGIS Pro has several preset formats for exporting movie animations. Some of these can 
be further customized using the File Export Settings and Advanced Movie Export Settings 
below the Movie Export Presets in the Export Movie Window. 

 

 In the File Name box, click the folder icon and browse to where you want 
to save the movie file. 

 Click the Export button at the bottom right of the Export Movie window. 

 

There are a lot of settings and other parameters that affect the quality of the final movie 
animation, as well as the amount of time required to export the movie animation. It is not 
uncommon for some movie animations to take multiple hours to export.  

 

 Save your project. 

 
 
 


